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Introduction 
 
CFS2 introduced a new sort of scenery to augment the traditional BGL scenery system inherited from 
earlier versions of Flight Simulator. This new scenery is Global Scenery Layer (GSL) scenery. 
 
It has one major advantage over the more normal scenery methods. It provides objects that appear in 
the permanent scenery but act like objects placed as part of a mission. They are fully crashable and 
destroyable even during Free Flight and Quick Combat. 
 
It can also display any currently installed Aircraft or Ship as a static object. 
 

Global Scenery Layer 
 
This consists of 3 main components. Firstly a single GSL file containing all the instructions where to 
display what. Secondly a series of Library BGL files that contain the drawing code for all the objects 
that can be displayed by GSL. Thirdly for each object that is used in the GSL an individual Damage 
Profile (DP) file. 
 
The single GSL file is called CFS2.GSL and is found in the GSL folder in CFS2. 
 
The Library files can be located in any valid scenery folder. The default ones are contained in the Inf 
(buildings) and  Veh (vehicles) folders. As well as Library objects GSL can utilise anything installed 
with an MDL file (basically Aircraft and Ships).  
 
The Library object DP files are all located in the OBJECTS_DP folder in CFS2. Aircraft and Ships 
have their own DP files in their own folders and do not require one in OBJECTS_DP. 
 
There are also other support files such as the entries in Descrip.dat and the thumbnails of individual 
objects in the INFO folder. These are not required by GSL but are mainly there for when you are 
designing a mission in Mission Builder. 
 
The Global Scenery Layer consists of a fixed grid covering the whole Earth. Each section of this grid is 
a Gob area (Global Object area). Each gob area can contain a single group of objects. This is important 
to remember as you need to be aware of the fact that placing a new group in a gob area that already 
contains objects will replace the current objects rather than add to them.  There are ways to take this 
into account that will be discussed later. 
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Global Objects 
 
The following object types can be displayed in GSL scenery 
 

• Any Library object that has a matching DP file in OBJECTS_DP 
• Any Aircraft that is installed in your Aircraft Folder (including the AI-only ones) 
• Any Ship that is installed in your Ships folder 

 
Basically it means that, with a few exceptions, anything that can be placed in Mission Builder as an 
Infrastructure object can also be utilised in GSL. This is not really surprising as GSL is in fact a 
specialised form of mission that is always present in all flight modes. 

 
The following object types can not be displayed by GSL and need to be placed using normal BGL 
methods. 
 

• FS Runways 
• Ground polygons 
• FS default Buildings 
• FS Roads, Rivers, Railways, Taxiways 
• Flattens and Excludes 
• Navigation Aids 

 
Although actually most normal FS scenery objects can be used with GSL if you first make them into 
Library objects.  
 

The Tools 
 
To design GSL scenery for CFS2 you need a basic set of tools 
 

1. The CFS2 Mission Builder. This is what you use to actually design the placement of 
objects and then save out as “Layouts” for conversion to GSL 

 
2. GobCheck. This tool will take Layout files exported from Mission Builder and split them 

(if necessary) into multiple layouts. This is necessary when your layout covers more than 
one gob area. Even small sceneries, depending on where you place them, may fall on the 
border between 2 gob areas. 

 
3. GSLEdit. This is the tool that actually puts layout data into the GSL. It is used initially to 

import your data into the standard GSL and then to export from the standard GSL and 
import into a separate GSL so that the GSL scenery can be distributed to other users. 

 
4. Distribution Tools. These are needed when you want to pass on your wonderful new 

scenery for others to enjoy. These vary from simple command-line programs to more 
sophisticated tools. 

 
5. A normal Scenery Designing program such as Airport or FSSC. This will be needed for 

designing any non-GSL parts of your scenery. 
 
As well as the above you need a reasonable knowledge of Scenery design techniques and a working 
familiarity with the CFS2 Mission Builder. This document is not designed for people just taking their 
first steps into design but rather for existing designers who want to expand their expertise into this new 
area. 
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GSLEdit – a brief description 
 
The main tool that makes alteration to the default CFS2 GSL possible is the GSL Editor. 
This is a program that will display all the data contained in the GSL database, let you extract or remove 
existing data and to insert new data of your own design. 
 
The interface is fairly straightforward. 

 
The leftmost list displays all the individual areas (“gobs”) contained in the database. Where they 
correspond to a known Airbase the name will also be displayed. 
 
Clicking on an entry in this list will fill the 2nd list with a list of all the objects contained in that gob. 
 
Clicking on any of these will display various information on that individual object – position, heading 
and, if available, a picture. 
 
Existing gob entries can be removed from the database or they can be extracted either as “mini-gsl” 
files or as Layout files that can be loaded and edited using the CFS2 Mission Builder. 
 
Layouts that you have edited or designed from scratch in Mission Builder can be inserted into the 
current GSL database. 
 
I won’t go into too much detail on the various functions of the program. The main ones you are going 
to need are the “Extract” and “Insert” functions and these are discussed later in the tutorials. 
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Step by Step Simple GSL 
 
This is an example of the method for creating GSL scenery in a new location where none presently 
exists. If you intend to create new or additional scenery for an already-existing airbase then you need to 
see the “Modifying existing GSL scenery” section after reading through the step-by-step before you 
actually try creating. 

Step 1 : Preparing the area 
 
If your scenery is going to involve non-GSL objects such as Ground textures and runways then the best 
approach is to design that first using whatever scenery design program you normally use. Once the 
BGL scenery is created and installed you will be able to see it in the scenery at the next design stage 
and you will be able to place GSL objects exactly where you want them in relation to the fixed BGL 
scenery. 
 
Just design a bare-bones scenery consisting of the bits you can’t do via GSL. Flatten the area, put down 
surface textures, place the runways, add roads, taxiways or railways. 
 
There are several free programs for designing the BGL part of the scenery. The main ones are 
“Airport” and “FS Scenery Creator” (FSSC). If all you wish to add is a runway then this can be done 
using my MkAFD program. 
 
For information on creating normal BGL scenery these programs come with useful tutorials and there 
are many sources of information on the web. FSSC has a user’s forum where questions can usually be 
answered. 
 
It is not compulsory to create any BGL scenery. You can place GSL objects without any BGL scenery 
being present.  However the best visual results will be when you have something other than bare terrain 
to arrange your objects on. 
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Step 2 : Designing the source scenery 
 

• Start up Mission Builder   
 
• Move to the location where you wish to place the scenery.  You can do this by creating a 

new mission that starts from the location you want (or somewhere near) and then moving 
the display around until you are over your chosen spot. Zoom in fairly close. 

 
• Start placing objects exactly as if you were creating scenery to appear in a mission. You 

should always use the “Infrastructure” option when placing objects. You can still select 
from the Vehicle, Aircraft or Ships lists even when working in Infrastructure mode and 
they will then be placed as static objects rather than as part of a moving “unit”.  Moving 
objects will not appear in GSL. 

 
• When you are happy with your scenery click on one object. Now hold down the Shift key 

and drag out a rectangle that covers all the objects in the scenery. They should now all 
show as selected (green) 

 
• Press Ctrl+W. This will bring up a dialog to save the selected objects as a layout (LAY) 

file. These files are always saved to the LAYOUTS folder in CFS2. 
 

• In case you want to come back and edit the scenery again you should save the current 
mission. This can be reloaded later and you can edit the scenery objects before saving out 
a new layout. 

 
• You can also reload Layouts into Mission Builder. Just start Mission Builder and then 

press Ctrl+L. This will bring up a dialog to load a layout. It is important that you make 
sure the “Place Layout at original World location” box is checked before clicking ok. 
Mission Builder will then place the objects take you to correct location. If this box is not 
checked then you will be expected to manually place the layout. This can sometimes be 
useful if you want to duplicate an existing scenery somewhere else. 
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Step 3 : Checking the Gob area 
 

• Run the GobCheck program. 
 

• Click “Check Layout file” and browse to the LAY file you saved earlier. 
 

• If the whole of the layout falls within one gob area then you will just see a simple display 
of the objects and their distribution. If this appears with no warning messages then the 
layout is ok as it is and you can skip to the next section. Before doing so make a note of 
the gob number (eg 1248fa.gob) displayed. This may be needed later on. 

 

• If you get a warning that the objects fall into more than one gob area then you will be 
offered the option to split the file into separate areas. You should click ok. If you don’t 
split the file up you will only see some of your objects appearing in CFS2 

 
• If you have reached this stage you will find that your original LAY file has been joined by 

2 (or more) new ones in the same folder. If, for instance, your original LAY file was 
called “Dover.lay” then you will see “Dover00.lay”, “Dover01.lay” etc appearing. These 
numbered files are the ones you need to use at the next stage. Your original LAY file 
should now be discarded. 

 
• Before leaving GobCheck make a note of the gob numbers listed in the small list box. 

You will need these to keep track of your scenery later. 
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Step 4 : Adding your Layout to the default GSL 
 
This is the crucial stage that will actually get your new scenery appearing in CFS2. 
 
Start GSLEdit and you should see a window something like this…... 
 

If you are getting nothing displayed in the lists then you may need to manually Open CFS2.gsl. This 
can be done from the File menu by selecting “Open GSL” and then browsing the CFS2 GSL folder and 
selecting cfs2.gsl. 
 
The display lists every gob contained in the current GSL. Some of them will have Airbase names 
showing. These are the gobs that actually contain the Airbase scenery. The others contain either non-
airbase scenery or sometimes portions of an airbase scenery that fall outside the gob containing the 
main part. 
 
If you are getting no Airbases listed then go to the CFS2 menu and select “Update Airfield List”. The 
Airfield list is generated from the CFS2 Airbases.dat file so will contain all airfields that have been 
entered in there. If you create a new airfield and you want its name to appear in GSLEdit you will have 
to add the data to Airbases.dat. My MkAFD program provides a facility for generating the necessary 
text or you can just do it manually. To get your new Airbase entries displaying in GSLEdit use the 
“Update Airfield List” function to get GSLEdit to rebuild its list using your updated Airbases.dat. 
 
From the “Insert” menu select “Mission Builder Layout” and browse to the Layout you wish to insert. 
Once you ok the Open dialog the GSL will be rebuilt with your new layout added.  
 
Repeat for as many layouts as you wish to insert. 
 
Start CFS2 FreeFlight and go and admire your new scenery (or blow it up……) 
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Modifying Existing GSL Scenery 
 
The previous step-by-step assumed the simplest case where you want to create a new scenery where 
none has been present before. 
 
Often you might want to add extra objects to an existing airfield or place an additional scenery in close 
proximity to existing objects. 
 
As noted earlier “there can be only one” as far as gobs are concerned. If you want to add a single 
hangar to an existing airbase and you create your scenery following the simple example you will find 
that the airbase now only has your new hangar. All the rest will have disappeared. This is because your 
new gob (containing just the single hangar) has taken the place of the original gob (containing all the 
original scenery objects). 
 
In cases like this the method needs to be modified. The example below shows how to add extra objects 
to the scenery at the Midway airbase. The same principles apply whatever gob area you wish to 
modify. 
 

Exporting Existing Scenery for Modification (Midway example) 
 

• Run GSLEdit. Locate the gob containing Midway. 
 
• Select this gob and then select “Mission Builder Layout” from the Extract menu 

 

• Save this to your CFS2 Layouts folder as Midway.lay 
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Modifying the scenery in Mission Builder 
 
Start Mission Builder, Press Ctrl-L to bring up the “Load Layout” dialog. 

Highlight the midway.lay entry. Put a check in the “Place Layout at original World Location” box and 
then click ok. 

 

You will now be taken to Midway airbase and you will see all the objects contained in the gob 
displayed as infrastrucure icons. 
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You can now add new objects in the normal Mission Builder way. You can also move or remove any 
of the original objects. Take note however that there are in effect 2 of each object at the moment. The 
ones with the infrastructure icons and the ones underneath them that are still part of the GSL. It may 
seem confusing but you need to ignore the “underneath” ones. If you move one of the objects the object 
with the icon will move but the original will still be visible at the original location. When the GSL is 
rebuilt using your modified layout these “underneath” ones will vanish and the new GSL will contain 
just the objects and positions from your layout. 
 
Once you are happy with your modifications follow the same steps as for the Simple example to export 
your scenery from Mission Builder as a Layout file and then import this Layout file into the default 
GSL using GSLEdit. The imported layout will completely replace the original gob and you will now 
have scenery that is taken from your modified layout. 
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Other Program functions 
 

Run Mission Builder 
 
This menu option just provides a quick way to run the CFS2 Mission Builder. 
 

Run MB with selected Gob 
 
This option will start up the CFS2 Mission Builder with a temporary layout loaded in a specific 
location. The location and layout is decided by which gob is currently highlighted in the Gob list. 
 
This provides a quick way to view or edit a particular gob. 
 

Fly 
 
This is basically the same as “Run MB with selected gob” but creates the temporary mission in such a 
way that the player aircraft is placed a distance south of the scenery layout.  
 
If you click “Fly” in Mission Builder and then “Fly Now” you start flying north and heading towards 
the scenery. 
 

Quick Edit 
 
Sometimes all you want to do is remove a single object from a gob area or perhaps change a building 
from one type to another. 
 
If you double-click on any entry in the gob list you will see Notepad open up with the text of a Layout 
file loaded. This can be edited by removing the line(s) for the object(s) you wish to remove or by 
changing the object name at the beginning of a line to a different object name. 
 
If you save this file after editing you can import it back into the current GSL by using  “Mission 
Builder Layout” from the “Insert” menu and selecting the “__Last_Edit” layout file that will have 
appeared in your Layouts folder. 
 
Warning – Manual editing of Layout files is only recommended if you know what you are doing! 
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Preparing your scenery for Distribution 
 

Things to consider 
 
• Does your scenery use any non-default library objects or anything else that might not be present in 

every copy of CFS2? If so then you will need to include the necessary files in with your 
distribution package. These may be library BGL files, Textures for the objects, DP files or even 
complete Aircraft.  Your install package will need to be able to install these to the correct places 
and, if necessary, update the scenery library. Wherever possible you should stick to the default 
objects when designing in order to minimise the risk of things not being present on the target 
computer. 

 
• Does your scenery require a BGL component? If you have designed a “backdrop” BGL scenery 

containing Runways, ground textures and any other non-GSL scenery then you need to include all 
the necessary BGL files and Textures as well as routines (or instructions) for installing them so 
they will appear correctly in CFS2. All the usual rules for distributing a “normal” scenery package 
apply here. 

 
• Does any of your GSL scenery replace default GSL gob areas? If so then you need to consider how 

to cover the situation where the user may wish to revert back to the original. This can be just 
making a backup of the user’s existing cfs2.gsl before installing your replacements or it could be 
done more flexibly by providing, as part of the package, copies of the individual default gob areas 
concerned exported from an unmodified copy of cfs2.gsl. The user could then use the distribution 
tools to selectively put back the default gob areas they wish.     



GSL Scenery Design 29/10/04 

Page 15 of 23 
Copyright © 2004 Martin Wright 

Extracting the data 
 
To distribute your scenery you need to create GSL files containing your new scenery. This is easily 
done by running GSLEdit and locating the individual entries containing your new scenery. This is the 
reason you should have made a note of the gob numbers revealed by GobCheck earlier. 
 

One by one find the gob areas that correspond to your sceneries and use Extract, Single Gob GSL. You 
can either accept the offered filename (taken from the gob entry name) or choose your own more 
meaningful one. 
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Combining multiple individual GSL files 
 
While you can just distribute your scenery as a collection of individual GSL files exported from 
GSLEdit this is a bit untidy. 
 
The best method is to create a 
single custom GSL file containing 
all your gob areas. 
 
To do this select “Open GSL” from 
the File menu and select one of the 
individual GSL files you have just 
extracted. The list window will now 
show just that gob area 
 

Now select “Single Gob GSL” from 
the Insert menu and select one of the 
other individual GSL files you 
extracted. 
 
Repeat until you have imported all the 
individual GSL files containing your 
sceneries. 
 

You now have your initially 
loaded GSL file which 
contains all the data for your 
GSL scenery in a single GSL 
file. 
 
This is the file you need to 
install in the end user`s  
default GSL file. 
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Distributing your scenery 
 
This is not as straightforward as it might seem. For various reasons (legal and practical) you can’t just 
pass around modified copies of cfs2.gsl for others to enjoy your scenery. The legal problem is that the 
file is owned by Microsoft. More importantly distributing cfs2.gsl is not practical because it will 
replace the one the user already has. If their current GSL already contains additional scenery then all 
this will be lost when their cfs2.gsl is replaced with yours. And when you create your next scenery 
people won’t be able to use it without losing your previous scenery. This is the reason for the actions 
described in the “Preparing your scenery for Distribution” section. 
 
Obviously what is needed is a system that will let the user just insert the new data in their existing 
GSL. If they also have GSLEdit then they could use that to insert or remove your scenery. 
 
Far better though to have some simple system of just doing the inserting and removing functions. 
Either as part of a general Install setup or manually by the user. 
 
The GSL Distribution Pack contains a set of files to assist with installing and uninstalling custom gsl 
data on the end users PC. They depend on your install routine correctly placing the files into the CFS2 
GSL folder but the install routine can be as simple as a zip file containing the correct folder structure or 
even just simple instruction to the user to unzip to the GSL folder. 
 
It is not permitted to distribute GSLEdit with your scenery. The risk of the average user accidentally 
messing up their default GSL by clicking on the wrong thing is just too high.  GSLEdit remains as part 
of the Developers GSL package where it can be hoped that anyone tinkering with it will have a basic 
knowledge of scenery design and the way that CFS2 works. 
 
There are 2 methods for installing GSL scenery on a destination PC :- 
 

Using GSLMan 
 

GSLMan is a very simplified version of GSLEdit 
that will only let the user add and remove data for 
which they have a custom gsl file available. This 
avoids the possibility of inadvertently removing 
default gob areas. 
 

It will only work correctly when located in the 
CFS2 GSL folder. 
 
In this scenario you would install a copy of 
GSLMan.exe and your custom GSL file(s) to the 
user’s CFS2 GSL folder as part of the general 
installation of your scenery. They can then be 
instructed to run GSLMan from that location and 
select your named gsl file(s) before clicking the 
“Add” button (or “Remove” if they wish to 
uninstall your custom GSL scenery) 
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Using the commandline tools 
 
The programs GSL_Add.exe and GSL_Rem.exe are console applications that will perform the actions 
of adding (or removing) custom GSL data. 
 
Syntax :- 
 

GSL_Add <“custom.gsl”> [“Destination.gsl”] 
GSL_Rem <“custom.gsl”> [“Destination.gsl”] 
 
Destination.gsl is optional but if you leave off this parameter the programs will default to 
“cfs2.gsl” without any path. 
 

Examples :- 
 

GSL_Add “mynew.gsl”       
(adds mynew.gsl to cfs2.gsl in the current directory) 
 
GSL_Add “mynew.gsl” “c:\Games\CFS2\GSL\cfs2.gsl” 
(adds mynew.gsl from the current directory to the cfs2.gsl in the specified location) 
 
GSL_Add “C:\windows\temp\mynew.gsl” “c:\Games\CFS2\GSL\cfs2.gsl” 
(adds mynew.gsl from the specified location to cfs2.gsl in the specified location) 
 
If you use GSL_Rem instead of GSL_Add then the action will be to remove the data rather 
than add it. 
 

When run the programs will display information to the command window. If any errors were 
encountered then this will be displayed. 
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It is easiest if you install them to the user’s CFS2 GSL folder but they can be run from anywhere. The 
drawback if you run them from elsewhere is that you need to know the full path to the default cfs2.gsl 
file in order to get them to work. 
 
When placed in the CFS2 GSL folder you can do several things :- 
 

• Instruct the user to drag your custom gsl file and drop it on the appropriate program icon. 
This will perform the required action. 

 
• Instruct the user to open up a dos prompt, CD to the CFS2 GSL folder and type in the 

commands manually (not recommended…) 
 
• Install Batch files at the same time and instruct the user to run them (or run them yourself 

as part of the install routine).  These batch files would just contain the necessary 
commandline to Add (or remove) your custom GSL 

 
For example a batch file called “Add_Dover GSL.BAT” containing just the single line  
 

GSL_Add “dover.gsl” 
 

Make a backup! 
 
Whichever method you use for distributing your scenery it is highly recommended that part of your 
installation routine or instructions involve making a backup copy of the user’s existing cfs2.gsl file 
before performing any modifications to it.  
 
Nothing is completely foolproof and I will take no responsibility for any damage caused to the user’s 
GSL scenery.  It is important that you, as the scenery distributor, provide some option for restoring the 
previous status if all goes wrong as the result of a power failure or system problem. 
 
The code used by the GSL Tools has been extensively tested and has proved reliable but it is 
impossible to take account of every variation of system and CFS2-setup.  
 



GSL Scenery Design 29/10/04 

Page 20 of 23 
Copyright © 2004 Martin Wright 

Appendices 
 

Setting up GSLEdit 
 
Normally GSLEdit will set itself up automatically using registry setting for the location of CFS2 and 
the various files and folders. 
 
If you have invalid registry settings or if you have more than one installation of CFS2 then you may 
need to set some features manually. 
 
From the CFS2 Menu select “Locate CFS2” and browse to the correct copy of cfs2.exe. This is needed 
so that the program can locate the necessary programs and folders and also so that the Airfields list can 
be correctly updated. Then select “Open GSL” from the File menu and browse to CFS2.gsl which can 
be found in the GSL folder of your CFS2 installation. 
 

Mwgfx.dll 
 
GSLEdit uses mwgfx.dll for the display of  object images. If you are getting no images displayed even 
when you have selected a default object then this may be because you do not have mwgfx.dll installed 
on your system. The mwgfx dll package can be obtained from the website listed in the contacts section. 

Mission Builder problems 
 
The CFS2 Mission Builder is not an independent program. It is just CFS2 itself run in a special mode.  
 
If you have lost your Mission Builder shortcut you can create a new one by making a copy of your 
existing CFS2 shortcut, right-clicking on the copy and selecting “Properties”. In the “Target” box you 
will see the path to your CFS2.exe program.  
 
To the very end of this line add a space and then /BUILDER 
 
This new shortcut will now run CFS2 in Mission Builder mode. Rename the shortcut to something 
suitable. 
 
If you get a warning that the Databases are corrupt when you try to run Mission Builder the most likely 
cause is that you have too many Aircraft installed. Move out some of your addon aircraft and try again. 
 
Note that the CFS2 Mission Builder requires a screen resolution of at least 1024x768 in order to run. If 
you are running a resolution lower than this then Mission Builder will fail to run. 
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Problems with GobCheck on non-English systems 
 
There has been identified a problem with the use of GobCheck on systems that have the decimal 
delimiters set different from the standard English/American use of the period (dot) for the decimal 
point and the comma for the “thousands”.  This shows up as the incorrect splitting of layouts. 
 
On these systems you may need to set the numbering system to English or US to get the correct output. 

Problems with Addon Aircraft 
 
GSL allows the display of any installed aircraft (flyable or AI-only). However these will be displayed 
using the standard CFS2 aircraft variables to place them “Wheels down and engine off”. This can cause 
problems with aircraft designed using different animation systems. Most addon aircraft will have been 
designed using FSDS or AF99 along with AircraftAnimator. These use totally different variables for 
animation and so may appear incorrectly when placed as GSL scenery objects. Typically they will 
appear with their landing gear not visible and sometimes they will appear with no propellors or with the 
props turning. This is the same effect as when you use older addon aircraft as wingmen in missions. 
You will find that they sit on the runway with no landing gear and often with no prop. 
 
The latest generation of addon aircraft designed using Gmax or FSDS2 should appear correctly but 
older addons may have to be avoided in GSL scenery.  
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CFS3 Notes 
 
The tools and techniques in this package are designed for CFS2 only. 
 
CFS3 uses a system that has some similarities on the surface but is very different underneath.  Any 
attempt to use the programs from this package on the CFS3 GSL files will fail and may also corrupt the 
CFS3 files themselves. 
 

Adapting scenery objects for GSL use 
 
GSL scenery can only utilise objects that are in the CFS2 object system. This means only Library 
objects and Aircraft/Ship MDL files. 
 
Many scenery objects are available as macros to be used in scenery design programs. These cannot be 
used by GSL. In order to make them usable they need to be converted to Library objects contained in 
Library BGL files. The process of modifying code and creating library BGLs is outside the scope of 
this document. It should be noted that as well as creating the Library objects you must also create a DP 
file of the same name as each library object for placement in the OBJECTS_DP folder in CFS2. 
 
The easiest way to create a DP file for a custom object is to make a copy of a similar default one. For 
example if you have a custom Hangar object called my_hangar then make a copy of the DP file of the 
default hangar closest in size to your design and rename this to “my_hangar.dp”. You can of course 
design a completely custom DP with custom damage values and effects but that is a more complex 
process and is best left for people with experience of Damage Profile design. 
 
Unfortunately the main object design programs provide no direct Library-format output.  FSDS will 
allow the output of scasm source code that can be manually edited to the correct format before 
compiling. The “FSRegen” program (http://www.nhreas.com/fsregen.html) has a Library tool that can 
convert the output from Gmax to a library format. There are also tutorials available around the Web on 
the subject of Libraries and the creation of CFS2 weapons libraries (exactly the same principle is used 
for creating scenery object libraries). 
 

http://www.nhreas.com/fsregen.html
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Copyrights 
 
All the items in this package are Copyright © 2001-2004 Martin Wright. You may not redistribute any 
part of the package in any format except those items specifically listed below under “Redistributable 
files”. 
 
You may use the programs provided in this package for the creation of GSL scenery for your own 
personal use on your own Computer. 
 
You may use the programs provided in this package for the creation of GSL scenery to distribute as 
part of a general add-on product for Combat Flight Simulator 2 only if the product is to be distributed 
as Freeware with no charge being made for it. 
 
You may not use the programs provided in this package for the design, creation or distribution of any 
part of a product that is to be sold commercially unless written permission has been obtained from the 
author. 
 

Redistributable Files 
 
The following items may be redistributed for the purposes of installing and uninstalling GSL scenery 
on other computers only as part of a product that is distributed free of charge. 
 

• GSL_Add.exe 
• GSL_Rem.exe 
• GSLMan.exe 

 

Contacts 
 

Email  mnwright@btinternet.com

Website  http://fly.to/mwgfx/
http:// www.mnwright.btinternet.co.uk/

www.mnwright.btinternet.co.uk/
http://fly.to/mwgfx/
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